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Symbols Used in This Document

Warning
Instructions that, if ignored, could result in death, serious personal injury, or property damage caused by
incorrect operation of the equipment. These must be observed for safe operation.

Caution
Instructions that, if ignored, could result in personal injury or property damage caused by incorrect
operation of the equipment. These must be observed for safe operation.

Important
Instructions including important information that must be observed to avoid damage and injury or
improper use of the product. Be sure to read these instructions.

Note
Instructions including notes for operation and additional explanations.

Basics

Instructions explaining basic operations of your product.

Note
• Icons may vary depending on your product.
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Trademarks

• Microsoft is a registered trademark of Microsoft Corporation.
• Windows is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other

countries.
• Windows Vista is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other

countries.
• Microsoft Edge and Excel are either trademarks or registered trademarks of Microsoft Corporation in the

U.S. and/or other countries.
• Internet Explorer is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or

other countries.
• Mac, Mac OS, macOS, OS X, AirPort, App Store, AirPrint, the AirPrint logo, Safari, Bonjour, iPad, iPad

Air, iPad mini, iPadOS, iPhone and iPod touch are trademarks of Apple Inc., registered in the U.S. and
other countries.

• IOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under
license.

• Google Cloud Print, Google Chrome, Chrome OS, Chromebook, Android, Google Drive, Google Apps
and Google Analytics are either registered trademarks or trademarks of Google Inc. Google Play and
Google Play Logo are trademarks of Google LLC.

• Adobe, Acrobat, Flash, Photoshop, Illustrator, Adobe RGB and Adobe RGB (1998) are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.

• Adobe, Acrobat, Flash, Photoshop, Photoshop Elements, Lightroom, Adobe RGB and Adobe RGB
(1998) are either registered trademarks or trademarks of Adobe Systems Incorporated in the United
States and/or other countries.

• Google, Google Home, and Android are trademarks of Google LLC.
• App Store is a trademark of Apple Inc., registered in the U.S. and other countries.
• Bluetooth is a trademark of Bluetooth SIG, Inc., U.S.A. and licensed to Canon Inc.
• AOSS™ is a trademark of BUFFALO INC.
• Autodesk and AutoCAD are registered trademarks or trademarks of Autodesk, Inc., and/or its

subsidiaries and/or affiliates in the USA and/or other countries.
• QR Code is a registered trademark of DENSO WAVE INCORPORATED in Japan and in other

countries.
• The Mopria® word mark and the Mopria® Logo are registered and/or unregistered trademarks of Mopria

Alliance, Inc. in the United States and other countries. Unauthorized use is strictly prohibited.
• HP-GL and HP-GL/2 are either registered trademarks or trademarks of HP Inc. in the United States

and/or other countries.
• Mozilla Firefox is a trademark or registered trademark of Mozilla Foundation in the U.S. and/or other

countries.
• Wi-Fi, WPA, WPA2 and WPA3 are either registered trademarks or trademarks of Wi-Fi Alliance.
• All other company names and products mentioned in this guide may be registered trademarks or

trademarks of their respective companies.

Note
• The formal name of Windows Vista is Microsoft Windows Vista operating system.
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Licenses

Copyright (c) 2003-2015 Apple Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of Apple Inc. ("Apple") nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN
NO EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA,
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/
TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.1.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting
the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled
by, or are under common control with that entity. For the purposes of this definition, "control" means
(i) the power, direct or indirect, to cause the direction or management of such entity, whether by
contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii)
beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to
software source code, documentation source, and configuration files.
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"Object" form shall mean any form resulting from mechanical transformation or translation of a Source
form, including but not limited to compiled object code, generated documentation, and conversions to
other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under
the License, as indicated by a copyright notice that is included in or attached to the work (an example
is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or
derived from) the Work and for which the editorial revisions, annotations, elaborations, or other
modifications represent, as a whole, an original work of authorship. For the purposes of this License,
Derivative Works shall not include works that remain separable from, or merely link (or bind by name)
to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work
and any modifications or additions to that Work or Derivative Works thereof, that is intentionally
submitted to Licensor for inclusion in the Work by the copyright owner or by an individual or
Legal Entity authorized to submit on behalf of the copyright owner. For the purposes of this
definition, "submitted" means any form of electronic, verbal, or written communication sent to the
Licensor or its representatives, including but not limited to communication on electronic mailing lists,
source code control systems, and issue tracking systems that are managed by, or on behalf of,
the Licensor for the purpose of discussing and improving the Work, but excluding communication
that is conspicuously marked or otherwise designated in writing by the copyright owner as "Not a
Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution
has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable
copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform,
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except
as stated in this section) patent license to make, have made, use, offer to sell, sell, import, and
otherwise transfer the Work, where such license applies only to those patent claims licensable by
such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of
their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute
patent litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that
the Work or a Contribution incorporated within the Work constitutes direct or contributory patent
infringement, then any patent licenses granted to You under this License for that Work shall terminate
as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in4.
any medium, with or without modifications, and in Source or Object form, provided that You meet the
following conditions:

1. You must give any other recipients of the Work or Derivative Works a copy of this License; and
2. You must cause any modified files to carry prominent notices stating that You changed the files;

and
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3. You must retain, in the Source form of any Derivative Works that You distribute, all copyright,
patent, trademark, and attribution notices from the Source form of the Work, excluding those
notices that do not pertain to any part of the Derivative Works; and

4. If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works4.
that You distribute must include a readable copy of the attribution notices contained within such
NOTICE file, excluding those notices that do not pertain to any part of the Derivative Works, in
at least one of the following places: within a NOTICE text file distributed as part of the Derivative
Works; within the Source form or documentation, if provided along with the Derivative Works;
or, within a display generated by the Derivative Works, if and wherever such third-party notices
normally appear. The contents of the NOTICE file are for informational purposes only and do not
modify the License. You may add Your own attribution notices within Derivative Works that You
distribute, alongside or as an addendum to the NOTICE text from the Work, provided that such
additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or
different license terms and conditions for use, reproduction, or distribution of Your modifications,
or for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of
the Work otherwise complies with the conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions
of this License, without any additional terms or conditions. Notwithstanding the above, nothing herein
shall supersede or modify the terms of any separate license agreement you may have executed with
Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade names, trademarks, service
marks, or product names of the Licensor, except as required for reasonable and customary use in
describing the origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides
the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without
limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY,
or FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the
appropriateness of using or redistributing the Work and assume any risks associated with Your
exercise of permissions under this License.

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence),
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent
acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct,
indirect, special, incidental, or consequential damages of any character arising as a result of this
License or out of the use or inability to use the Work (including but not limited to damages for loss of
goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages
or losses), even if such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof,
You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other
liability obligations and/or rights consistent with this License. However, in accepting such obligations,
You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other
Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any
liability incurred by, or claims asserted against, such Contributor by reason of your accepting any
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such warranty or additional liability.
END OF TERMS AND CONDITIONS

---- Part 1: CMU/UCD copyright notice: (BSD like) -----

Copyright 1989, 1991, 1992 by Carnegie Mellon University

Derivative Work - 1996, 1998-2000

Copyright 1996, 1998-2000 The Regents of the University of California

All Rights Reserved

Permission to use, copy, modify and distribute this software and its documentation for any purpose and
without fee is hereby granted, provided that the above copyright notice appears in all copies and that both
that copyright notice and this permission notice appear in supporting documentation, and that the name of
CMU and The Regents of the University of California not be used in advertising or publicity pertaining to
distribution of the software without specific written permission.

CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALL WARRANTIES
WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL CMU OR THE REGENTS OF THE
UNIVERSITY OF CALIFORNIA BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL
DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM THE LOSS OF USE, DATA OR
PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION,
ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

---- Part 2: Networks Associates Technology, Inc copyright notice (BSD) -----

Copyright (c) 2001-2003, Networks Associates Technology, Inc

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of the Networks Associates Technology, Inc nor the names of its contributors may be
used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ``AS
IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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---- Part 3: Cambridge Broadband Ltd. copyright notice (BSD) -----

Portions of this code are copyright (c) 2001-2003, Cambridge Broadband Ltd.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* The name of Cambridge Broadband Ltd. may not be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER ``AS IS'' AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

---- Part 4: Sun Microsystems, Inc. copyright notice (BSD) -----

Copyright c 2003 Sun Microsystems, Inc., 4150 Network Circle, Santa Clara, California 95054, U.S.A. All
rights reserved.

Use is subject to license terms below.

This distribution may include materials developed by third parties.

Sun, Sun Microsystems, the Sun logo and Solaris are trademarks or registered trademarks of Sun
Microsystems, Inc. in the U.S. and other countries.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of the Sun Microsystems, Inc. nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ``AS
IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
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SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 5: Sparta, Inc copyright notice (BSD) -----

Copyright (c) 2003-2012, Sparta, Inc

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of Sparta, Inc nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ``AS
IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 6: Cisco/BUPTNIC copyright notice (BSD) -----

Copyright (c) 2004, Cisco, Inc and Information Network Center of Beijing University of Posts and
Telecommunications.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of Cisco, Inc, Beijing University of Posts and Telecommunications, nor the names of
their contributors may be used to endorse or promote products derived from this software without specific
prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ``AS
IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
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ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 7: Fabasoft R&D Software GmbH & Co KG copyright notice (BSD) -----

Copyright (c) Fabasoft R&D Software GmbH & Co KG, 2003 oss@fabasoft.com

Author: Bernhard Penz <bernhard.penz@fabasoft.com>

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* The name of Fabasoft R&D Software GmbH & Co KG or any of its subsidiaries, brand or product names
may not be used to endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER ``AS IS'' AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

---- Part 8: Apple Inc. copyright notice (BSD) -----

Copyright (c) 2007 Apple Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of Apple Inc. ("Apple") nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
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OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN
NO EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA,
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

---- Part 9: ScienceLogic, LLC copyright notice (BSD) -----

Copyright (c) 2009, ScienceLogic, LLC

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of ScienceLogic, LLC nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 10: Lennart Poettering copyright notice (BSD-like) -----

Copyright 2010 Lennart Poettering

Permission is hereby granted, free of charge, to any person
obtaining a copy of this software and associated documentation files
(the "Software"), to deal in the Software without restriction,
including without limitation the rights to use, copy, modify, merge,
publish, distribute, sublicense, and/or sell copies of the Software,
and to permit persons to whom the Software is furnished to do so,
subject to the following conditions:

14



The above copyright notice and this permission notice shall be
included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS
BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN
ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

---- Part 11: IETF copyright notice (BSD) -----

Copyright (c) 2013 IETF Trust and the persons identified as authors of
the code. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

* Neither the name of Internet Society, IETF or IETF Trust, nor the
names of specific contributors, may be used to endorse or promote
products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER
OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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---- Part 12: Arista Networks copyright notice (BSD) ----

Copyright (c) 2013, Arista Networks, Inc.

All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

* Neither the name of Arista Networks, Inc. nor the names of its
contributors may be used to endorse or promote products derived
from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING,
BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

---- Part 13: VMware, Inc. copyright notice (BSD) -----

Copyright (c) 2016, VMware, Inc.

All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.
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* Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

* Neither the name of VMware, Inc. nor the names of its contributors
may be used to endorse or promote products derived from this software
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 14: USC/Information Sciences Institute copyright notice (BSD) -----

Copyright (c) 2017-2018, Information Sciences Institute

All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

* Neither the name of Information Sciences Institue nor the names of its
contributors may be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
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PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

MIT License

Copyright (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS
OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR
IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Copyright 2000 Computing Research Labs, New Mexico State University

Copyright 2001-2015 Francesco Zappa Nardelli

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE COMPUTING
RESEARCH LAB OR NEW MEXICO STATE UNIVERSITY BE LIABLE FOR ANY CLAIM, DAMAGES
OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING
FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

Written by Joel Sherrill <joel@OARcorp.com>.

COPYRIGHT (c) 1989-2000.

On-Line Applications Research Corporation (OAR).
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Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby
granted, provided that this entire notice is included in all copies of any software which is or includes a
copy or modification of this software.

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY.
IN PARTICULAR, THE AUTHOR MAKES NO REPRESENTATION OR WARRANTY OF ANY KIND
CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY
PARTICULAR PURPOSE.

(1) Red Hat Incorporated

Copyright (c) 1994-2009 Red Hat, Inc. All rights reserved.

This copyrighted material is made available to anyone wishing to use, modify, copy, or redistribute it
subject to the terms and conditions of the BSD License. This program is distributed in the hope that it
will be useful, but WITHOUT ANY WARRANTY expressed or implied, including the implied warranties of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. A copy of this license is available at
http://www.opensource.org/licenses. Any Red Hat trademarks that are incorporated in the source code or
documentation are not subject to the BSD License and may only be used or replicated with the express
permission of Red Hat, Inc.

(2) University of California, Berkeley

Copyright (c) 1981-2000 The Regents of the University of California.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of the University nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The FreeType Project LICENSE

----------------------------

2006-Jan-27

Copyright 1996-2002, 2006 by
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David Turner, Robert Wilhelm, and Werner Lemberg

Introduction

============

The FreeType Project is distributed in several archive packages; some of them may contain, in addition to
the FreeType font engine, various tools and contributions which rely on, or relate to, the FreeType Project.

This license applies to all files found in such packages, and which do not fall under their own explicit
license. The license affects thus the FreeType font engine, the test programs, documentation and
makefiles, at the very least.

This license was inspired by the BSD, Artistic, and IJG (Independent JPEG Group) licenses, which
all encourage inclusion and use of free software in commercial and freeware products alike. As a
consequence, its main points are that:

o We don't promise that this software works. However, we will be interested in any kind of bug reports.
(`as is' distribution)

o You can use this software for whatever you want, in parts or full form, without having to pay us.
(`royalty-free' usage)

o You may not pretend that you wrote this software. If you use it, or only parts of it, in a program, you
must acknowledge somewhere in your documentation that you have used the FreeType code. (`credits')

We specifically permit and encourage the inclusion of this software, with or without modifications, in
commercial products.

We disclaim all warranties covering The FreeType Project and assume no liability related to The FreeType
Project.

Finally, many people asked us for a preferred form for a credit/disclaimer to use in compliance with this
license. We thus encourage you to use the following text:

"""

Portions of this software are copyright © <year> The FreeType

Project (www.freetype.org). All rights reserved.

"""

Please replace <year> with the value from the FreeType version you actually use.

Legal Terms

===========

0. Definitions

--------------

Throughout this license, the terms `package', `FreeType Project', and `FreeType archive' refer to the set
of files originally distributed by the authors (David Turner, Robert Wilhelm, and Werner Lemberg) as the
`FreeType Project', be they named as alpha, beta or final release.

`You' refers to the licensee, or person using the project, where `using' is a generic term including
compiling the project's source code as well as linking it to form a `program' or `executable'.

This program is referred to as `a program using the FreeType engine'.
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This license applies to all files distributed in the original FreeType Project, including all source code,
binaries and documentation, unless otherwise stated in the file in its original, unmodified form as
distributed in the original archive.

If you are unsure whether or not a particular file is covered by this license, you must contact us to verify
this.

The FreeType Project is copyright (C) 1996-2000 by David Turner, Robert Wilhelm, and Werner Lemberg.
All rights reserved except as specified below.

1. No Warranty

--------------

THE FREETYPE PROJECT IS PROVIDED `AS IS' WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT WILL ANY OF THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY DAMAGES CAUSED BY THE USE OR THE INABILITY
TO USE, OF THE FREETYPE PROJECT.

2. Redistribution

-----------------

This license grants a worldwide, royalty-free, perpetual and irrevocable right and license to use, execute,
perform, compile, display, copy, create derivative works of, distribute and sublicense the FreeType Project
(in both source and object code forms) and derivative works thereof for any purpose; and to authorize
others to exercise some or all of the rights granted herein, subject to the following conditions:

o Redistribution of source code must retain this license file (`FTL.TXT') unaltered; any additions, deletions
or changes to the original files must be clearly indicated in accompanying documentation. The copyright
notices of the unaltered, original files must be preserved in all copies of source files.

o Redistribution in binary form must provide a disclaimer that states that the software is based in part of
the work of the FreeType Team, in the distribution documentation. We also encourage you to put an URL
to the FreeType web page in your documentation, though this isn't mandatory.

These conditions apply to any software derived from or based on the FreeType Project, not just the
unmodified files. If you use our work, you must acknowledge us. However, no fee need be paid to us.

3. Advertising

--------------

Neither the FreeType authors and contributors nor you shall use the name of the other for commercial,
advertising, or promotional purposes without specific prior written permission.

We suggest, but do not require, that you use one or more of the following phrases to refer to this software
in your documentation or advertising materials: `FreeType Project', `FreeType Engine', `FreeType library',
or `FreeType Distribution'.

As you have not signed this license, you are not required to accept it. However, as the FreeType Project
is copyrighted material, only this license, or another one contracted with the authors, grants you the right
to use, distribute, and modify it.

Therefore, by using, distributing, or modifying the FreeType Project, you indicate that you understand and
accept all the terms of this license.

4. Contacts
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-----------

There are two mailing lists related to FreeType:

o freetype@nongnu.org

Discusses general use and applications of FreeType, as well as future and wanted additions to the library
and distribution.

If you are looking for support, start in this list if you haven't found anything to help you in the
documentation.

o freetype-devel@nongnu.org

Discusses bugs, as well as engine internals, design issues, specific licenses, porting, etc.

Our home page can be found at

http://www.freetype.org

--- end of FTL.TXT ---

The TWAIN Toolkit is distributed as is. The developer and distributors of the TWAIN Toolkit expressly
disclaim all implied, express or statutory warranties including, without limitation, the implied warranties
of merchantability, noninfringement of third party rights and fitness for a particular purpose. Neither the
developers nor the distributors will be liable for damages, whether direct, indirect, special, incidental, or
consequential, as a result of the reproduction, modification, distribution or other use of the TWAIN Toolkit.

JSON for Modern C++

Copyright (c) 2013-2017 Niels Lohmann

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS
OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR
IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Copyright (c) 2011 - 2015 ARM LIMITED

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

- Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
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- Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
- Neither the name of ARM nor the names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL COPYRIGHT HOLDERS AND CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright (c) 2014, Kenneth MacKay

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright (c) 2006, CRYPTOGAMS by <appro@openssl.org> All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain copyright notices, this list of conditions and the following
disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of the CRYPTOGAMS nor the names of its copyright holder and contributors may be
used to endorse or promote products derived from this software without specific prior written permission.
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ALTERNATIVELY, provided that this notice is retained in full, this product may be distributed under the
terms of the GNU General Public License (GPL), in which case the provisions of the GPL apply INSTEAD
OF those given above.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

ISC License

Copyright (c) 2013-2017

Frank Denis <j at pureftpd dot org>

Permission to use, copy, modify, and/or distribute this software for any purpose with or without fee is
hereby granted, provided that the above copyright notice and this permission notice appear in all copies.

THE SOFTWARE IS PROVIDED "AS IS" AND THE AUTHOR DISCLAIMS ALL WARRANTIES WITH
REGARD TO THIS SOFTWARE INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY SPECIAL, DIRECT,
INDIRECT, OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM
LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE
OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR
PERFORMANCE OF THIS SOFTWARE.

Copyright (c) 2008 The NetBSD Foundation, Inc.

All rights reserved.

This code is derived from software contributed to The NetBSD Foundation
by Lennart Augustsson (lennart@augustsson.net) at
Carlstedt Research & Technology.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:

1. Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE NETBSD FOUNDATION, INC. AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
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PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE FOUNDATION OR CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

Copyright (c) 2000 Intel Corporation

All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.
* Neither name of Intel Corporation nor the names of its contributors
may be used to endorse or promote products derived from this software
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL INTEL OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY
OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Lua

Copyright © 1994–2014 Lua.org, PUC-Rio.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated
documentation files (the "Software"), to deal in the Software without restriction, including without limitation
the
rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and
to
permit persons to whom the Software is furnished to do so, subject to the following conditions:
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The above copyright notice and this permission notice shall be included in all copies or substantial
portions of
the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER
IN AN
ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH
THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

LuaSocket

LuaSocket 2.0.2 license
Copyright © 2004-2007 Diego Nehab

Permission is hereby granted, free of charge, to any person obtaining a
copy of this software and associated documentation files (the "Software"),
to deal in the Software without restriction, including without limitation
the rights to use, copy, modify, merge, publish, distribute, sublicense,
and/or sell copies of the Software, and to permit persons to whom the
Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING
FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER
DEALINGS IN THE SOFTWARE.

LuneScript

Copyright (c) 2018 ifritJP

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.
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THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

Copyright (c) 2002-2019, Jouni Malinen <j@w1.fi> and contributors
All Rights Reserved.

This software may be distributed, used, and modified under the terms of
BSD license:

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

1. Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

3. Neither the name(s) of the above-listed copyright holder(s) nor the
names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright (C) 2019, Broadcom Corporation. All Rights Reserved.

Permission to use, copy, modify, and/or distribute this software for any
purpose with or without fee is hereby granted, provided that the above
copyright notice and this permission notice appear in all copies.
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THE SOFTWARE IS PROVIDED "AS IS" AND THE AUTHOR DISCLAIMS ALL WARRANTIES
WITH REGARD TO THIS SOFTWARE INCLUDING ALL IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY
SPECIAL, DIRECT, INDIRECT, OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION
OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN
CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The certificate files "Amazon Root CA 1", "Amazon Root CA 2", "Amazon Root CA 4" are licensed under a
Creative Commons Attribution-NoDerivatives 4.0 International License.

The following applies only to products supporting Wi-Fi.

(c) 2009-2013 by Jeff Mott. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions, and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and the
following disclaimer in the documentation or other materials provided with the distribution.
* Neither the name CryptoJS nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS," AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE,
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright 2008, Google Inc.

All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

* Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above
copyright notice, this list of conditions and the following disclaimer
in the documentation and/or other materials provided with the
distribution.
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* Neither the name of Google Inc. nor the names of its
contributors may be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
AS IS AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright (c) 1998-2010, Brian Gladman, Worcester, UK. All rights reserved.

The redistribution and use of this software (with or without changes)
is allowed without the payment of fees or royalties provided that:
source code distributions include the above copyright notice, this
list of conditions and the following disclaimer;
binary distributions include the above copyright notice, this list
of conditions and the following disclaimer in their documentation.

This software is provided 'as is' with no explicit or implied warranties
in respect of its operation, including, but not limited to, correctness
and fitness for purpose.

Disclaimer: IMPORTANT: This Apple software is supplied to you, by Apple Inc. ("Apple"), in your
capacity as a current, and in good standing, Licensee in the MFi Licensing Program. Use of this
Apple software is governed by and subject to the terms and conditions of your MFi License,
including, but not limited to, the restrictions specified in the provision entitled "Public
Software", and is further subject to your agreement to the following additional terms, and your
agreement that the use, installation, modification or redistribution of this Apple software
constitutes acceptance of these additional terms. If you do not agree with these additional terms,
please do not use, install, modify or redistribute this Apple software.

Subject to all of these terms and in consideration of your agreement to abide by them, Apple grants
you, for as long as you are a current and in good-standing MFi Licensee, a personal, non-exclusive
license, under Apple's copyrights in this original Apple software (the "Apple Software"), to use,
reproduce, and modify the Apple Software in source form, and to use, reproduce, modify, and
redistribute the Apple Software, with or without modifications, in binary form. While you may not
redistribute the Apple Software in source form, should you redistribute the Apple Software in binary
form, you must retain this notice and the following text and disclaimers in all such redistributions
of the Apple Software. Neither the name, trademarks, service marks, or logos of Apple Inc. may be
used to endorse or promote products derived from the Apple Software without specific prior written
permission from Apple. Except as expressly stated in this notice, no other rights or licenses,
express or implied, are granted by Apple herein, including but not limited to any patent rights that
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may be infringed by your derivative works or by other works in which the Apple Software may be
incorporated.

Unless you explicitly state otherwise, if you provide any ideas, suggestions, recommendations, bug
fixes or enhancements to Apple in connection with this software ("Feedback"), you hereby grant to
Apple a non-exclusive, fully paid-up, perpetual, irrevocable, worldwide license to make, use,
reproduce, incorporate, modify, display, perform, sell, make or have made derivative works of,
distribute (directly or indirectly) and sublicense, such Feedback in connection with Apple products
and services. Providing this Feedback is voluntary, but if you do provide Feedback to Apple, you
acknowledge and agree that Apple may exercise the license granted above without the payment of
royalties or further consideration to Participant.

The Apple Software is provided by Apple on an "AS IS" basis. APPLE MAKES NO WARRANTIES,
EXPRESS OR
IMPLIED, INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE, REGARDING THE APPLE SOFTWARE OR ITS USE
AND OPERATION ALONE OR
IN COMBINATION WITH YOUR PRODUCTS.

IN NO EVENT SHALL APPLE BE LIABLE FOR ANY SPECIAL, INDIRECT, INCIDENTAL OR
CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) ARISING IN ANY WAY OUT OF THE USE,
REPRODUCTION, MODIFICATION
AND/OR DISTRIBUTION OF THE APPLE SOFTWARE, HOWEVER CAUSED AND WHETHER UNDER
THEORY OF CONTRACT, TORT
(INCLUDING NEGLIGENCE), STRICT LIABILITY OR OTHERWISE, EVEN IF APPLE HAS BEEN
ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

Copyright (C) 2009 Apple Inc. All Rights Reserved.

Copyright (c) 2012-2013 Apple Inc. All rights reserved.

Copyright (C) 2013 Apple Inc. All Rights Reserved.

The following applies only to products supporting PIXUS Cloud Link, PIXMA Cloud Link, or MAXIFY Cloud
Link.

THE BASIC LIBRARY FUNCTIONS

---------------------------

Written by:       Philip Hazel
Email local part: ph10
Email domain:     cam.ac.uk
University of Cambridge Computing Service, Cambridge, England.
Copyright (c) 1997-2012 University of Cambridge
All rights reserved.
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PCRE JUST-IN-TIME COMPILATION SUPPORT

-------------------------------------

Written by:       Zoltan Herczeg
Email local part: hzmester
Emain domain:     freemail.hu
Copyright(c) 2010-2012 Zoltan Herczeg
All rights reserved.

STACK-LESS JUST-IN-TIME COMPILER

--------------------------------

Written by:       Zoltan Herczeg
Email local part: hzmester
Emain domain:     freemail.hu
Copyright(c) 2009-2012 Zoltan Herczeg
All rights reserved.

THE C++ WRAPPER FUNCTIONS

-------------------------

Contributed by:   Google Inc.
Copyright (c) 2007-2012, Google Inc.
All rights reserved.

THE "BSD" LICENCE

-----------------Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

* Neither the name of the University of Cambridge nor the name of Google
Inc. nor the names of their contributors may be used to endorse or
promote products derived from this software without specific prior
written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
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LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

This software is based in part on the work of the Independent JPEG Group.
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Accounting Manager Guide

General Notes (Accounting Manager)

The Features of Accounting Manager

Starting Accounting Manager

Exiting Accounting Manager

Accounting Manager Basic Procedures

Accounting Manager Basic Procedures

Registering Printer

Configure unit costs, including the costs of ink and paper

Setting Units Displayed

Setting List Display

Unregistering Managed Printer

Various Accounting Manager Features

Filtering Settings

Tabulating Costs

Exporting Cost Tabulation Results to CSV File

Exporting/Importing Job Logs as File

Exporting Cost Information to a File

Displaying Various Information

Checking Unit Costs Set on Printer

Checking Consumption

Checking Errors During Job Log Acquisition

Checking the Status of the Scheduled Export of Cost Information

Description of Accounting Manager Screen
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Main Window

Filter Job Log Dialog Box

Cost Tabulation Dialog Box

Specified Unit Cost Dialog Box

Ink and Paper Consumed Dialog Box

Job Properties Dialog Box

Unit Costs Dialog Box

Resident Service Settings Dialog Box

Printer Management Dialog Box

Check Operation Status Dialog Box

Preferences Dialog Box

Job Log Management Dialog Box

Scheduled Export of Cost Data Dialog Box

CSV Settings Dialog Box

Important
• Depending on your model or software version, you cannot use some function.•
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General Notes (Accounting Manager)

When using Accounting Manager, the following restrictions apply. Please familiarize yourself with them
before using it.

• See the Canon website for products that are compatible with Accounting Manager.•

• This guide primarily provides explanations using the screens that appear when you use the Windows 10•
operating system (hereafter, Windows 10).

Connecting to a Printer
• Connecting to a Target Printer•

We recommend using a network connection for printer connection.

A USB connection is also possible, but job logs cannot be acquired during printing.

• When Connecting to Network Using DHCP•

If the a managed printer is set to automatically obtain an IP address, the IP address change is tracked
automatically.

Important
• When the power is turned off on a printer connected to a network using DHCP, the IP address•

may change the next time the printer is turned on.

In Accounting Manager v1.2.0 or later, the reassignment of the IP address is tracked
automatically, but if the IP address changes again within a certain period of time, communication
may fail. In this case, if you wait a little while, the reassigned IP address will be tracked, and
communication will be restored.

• Automatic tracking of an IP address for a printer connected to a network using DHCP applies to•
printers registered with Accounting Manager v1.2.0 or later. Automatic tracking of IP addresses is
not performed on printers registered with a previous version.

• Connecting via SSL Encrypted Communication•

Connecting via SSL Encrypted Communication is available with Accounting Manager V1.2.0 or later.

In order to use SSL Encrypted Communication, you must first install a certificate on a computer with
Accounting Manager installed.

The process for installing the certificate may differ depending on your setup. For more information,
search for "Registering Printer's Root Certificate to Local Computer for SSL Communication" on your
device's online manual homepage.

Power Status of a Target Printer
• The printer information cannot be acquired when the printer has auto powered off or has been turned•

off with the Power button.
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In addition, job logs or information cannot be acquired from the software when the printer auto power
off state or the printer button off state is canceled.
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The Features of Accounting Manager

Accounting Manager is a software program that constantly communicates with managed printers to collect
job logs. The collected job logs are saved to the hard disk of your computer.

You can use Accounting Manager to do the following actions.

• Print Job Log Collection•

This allows you to check which documents were printed from each printer, who printed them and when.

• Calculation of the Total Pages Used and the Total Cost•

This allows you to use the collected print job logs to calculate totals for items such as the number of
pages printed, the amount of paper used and the printing costs incurred.

• Regular Data Acquisition for Print Jobs•

Acquires job logs regularly.

• Exporting Job Logs•

You can export the collected job logs to a file.

Note
• If the computer on which Accounting Manager is installed is not turned on or the computer is in sleep•

mode, the job logs cannot be collected.

To acquire job logs without fail, it is recommended that you install Accounting Manager on the computer
used for administration and keep it constantly running for use.

Important
• Accounting Manager displays estimates for the amount of ink consumed per print and paper consumed.•

The actual consumption may be different.

The average error for estimates based on the Canon ink cost measurement conditions is ±15%. Canon
cannot guarantee the accuracy of these estimates. These estimates will also vary depending on the
conditions of printer use.

Note also that these estimates do not include ink consumed in procedures such as forced nozzle
discharges by the cleaning mechanism.
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Starting Accounting Manager

Follow the procedure below to start the Accounting Manager.

Execute any of the following:

• Click the Accounting Manager button on the Management Tool sheet in the Quick Utility Toolbox.•

• Start from Program.•

◦ For Windows 11/Windows 10◦

From the Start menu, click (All apps >) Canon Utilities > Accounting Manager.

◦ For Windows 8.1◦

Click Accounting Manager on the Start screen.

If Accounting Manager does not appear on the Start screen, select the Search charm, and search
for Accounting Manager.

◦ For Windows 7◦

From Start menu, select All Programs > Canon Utilities > Accounting Manager, and then click
Accounting Manager.

Note
• Quick Utility Toolbox is a Canon software application.•

• When Accounting Manager is started, job logs are not acquired.•

When started, the acquired information appears, starting with the most recently saved job log.

You can acquire job logs at scheduled intervals using Scheduled Acquisition Settings in Advanced
Printer Settings and, as needed, by utilizing Refresh and Cost Tabulation.

• When a printer is registered as a managed printer, the initial job log is acquired.•

• If Resident Service Settings is set to Start and you register the managed printer, job log acquisition•
starts.
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Exiting Accounting Manager

The procedure for exiting Accounting Manager is shown below.

• Clicking the Close button on the title bar of the main screen.•

• Selecting Exit from the File menu.•

Note
• If the printer is being accessed when exiting, a message indicating that exiting is in progress appears.•

After exiting is completed, Accounting Manager exits.

• If Start is set in Resident Service Settings, job logs are acquired regularly in the background even•
after exiting.
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Accounting Manager Basic Procedures

 Accounting Manager Basic Procedures

 Registering Printer

 Configure unit costs, including the costs of ink and paper

 Setting Units Displayed

 Setting List Display

 Unregistering Managed Printer
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Accounting Manager Basic Procedures

The first time you use the Accounting Manager, use the following procedures to configure the settings.

1. Registering Printer1.

For details on how to add a managed printer, see "Registering Printer."

2. Configure unit costs, including the costs of ink and paper2.

For details on the unit cost settings, see "Configure unit costs, including the costs of ink and paper."

3. Setting Options Such as Units Displayed3.

For details on the units setting, see "Setting Units Displayed."

4. Setting List Display4.

For details of how to set the list display, see "Setting List Display."

This displays the required print job logs and lists the details.

Note
• You can save collected job logs to a file.•

For details, see "Exporting/Importing Job Logs as File."
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Registering Printer

Register printers to be managed.

1. Click  Printer Management button or select Manage Printer from Printer of File1.
menu.

The Printer Management dialog box appears.

2. Click Add Printer button.2.
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The Add Printer dialog box appears.

Note
• For details on the Add Printer dialog box, see "Printer Management Dialog Box."•

3. Select Auto (IPv4/IPv6) in Search Method, and click Search button.3.

The -printers found appear in Printer List.

Note
• If the printer you want to register does not appear, check that the printer power is turned on and•

check the network status, and then search again.

• If the printer still does not appear, select IPv4, IPv6, or USB in Search Method, and then search.•

If you select IPv4 or IPv6, enter the IP address in IP Address.

• To search by SNMP Community, click Search Options, and then specify a Specify community•
name.

• When Search Method is set to USB, a search for local printers is performed.•

4. Select printer to be registered from printers found and click Add button.4.

The added printers appear in Printer List in the Printer Management dialog box.

5. Click Advanced Settings with printer selected in Printer List.5.

The Advanced Printer Settings dialog box opens.

6. Check Scheduled Acquisition Settings.6.

Check that Run scheduled job log acquisition in Scheduled Acquisition Settings is selected.

7. Set Password in Authentication.7.
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Set a Password in Authentication if necessary.

Note
• If the job history is set to hide on the printer control panel, authentication information is required•

when acquiring job logs.

• For details, search for and refer to the "Administrator Password" page from the home page of the•
Online Manual for your model.

After setting Password, click Auth. Test button to check authentication.

8. Click the Add button.8.

Settings are applied and the Advanced Printer Settings dialog box closes.

9. Click the OK button.9.

Information is acquired, and the printer is registered.

When the printer registration is completed, job log acquisition starts.

The acquired job logs are saved to your computer.

Note
• Before acquiring job logs, Accounting Manager refers to the MAC Address to check whether the•

communication destination printer is the registered printer.

If the MAC address is different than the one for the registered printer, job logs are not acquired.

• For details on how to unregister a managed printer, see "Unregistering Managed Printer."•

44



Configure unit costs, including the costs of ink and paper

Configure unit costs, including the costs of ink and paper.

Note
• Unit costs are set for each printer being managed.•

Opening Unit Costs Dialog Box
The Unit Costs dialog box opens.

1. Select printer you want to register unit costs for from printer list.1.

2. Click the  Unit Costs button or select Unit Costs from Job Cost in the File menu.2.

The Unit Costs dialog box appears.

The Unit Costs dialog box consists of the following sheets.

Ink sheet : Setting the Unit Cost for Ink
Paper sheet : Setting the Unit Cost for Paper
Others sheet : Setting the Unit Cost for Items Other Than Ink and Paper

You can copy unit costs set on a printer to another printer using "Copying Unit Costs".

Setting the Unit Cost for Ink
Set the ink unit costs using the Ink sheet.

Click Ink tab to display it.
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To set different unit costs for each ink color
1. Select ink to be changed.1.

2. Edit Unit Costs and Ink Tank Capacity directly in list.2.

To enable editing, double-click the item to be edited.

3. Click the OK button.3.

To set the same unit cost for all the inks
1. Select ink color to be copied.1.

2. Click Apply to All Inks button.2.

The selected ink unit cost and tank capacity are applied to all ink colors.

3. Click the OK button.3.

Setting the Unit Cost for Paper
Set paper unit costs using Paper sheet.

Click Paper tab to display it.
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Adding Paper Unit Costs
1. Click the Add button.1.

The Add Paper Unit Cost dialog box appears.
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2. Set Media Type, Paper Size, and Unit Costs.2.

Set Width, Height, and Number of Sheets/Rolls as necessary.

Note
• For Roll Paper, specify the number of rolls in Number of Sheets/Rolls.•

3. Click Start button.3.

The unit cost settings you added are added to the Unit Cost List.

Editing Paper Unit Costs
The procedure for editing paper unit costs is shown below.

Editing the Unit Cost List in the List

1. Edit Width, Height, Number of Sheets/Rolls, and Unit Costs directly in Unit Cost List.1.

To enable editing, double-click the item to be edited.

2. Click the OK button.2.

When you finish editing, click OK button.

Editing with Edit Paper Unit Cost Dialog Box

1. Click Edit button.1.

The Edit Paper Unit Cost dialog box appears.
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2. Edit item to be changed.2.

3. Click the Update button.3.

When you finish editing, click Update button and close Edit screen.

4. Click the OK button.4.

Setting the Unit Cost for Items Other Than Ink and Paper
Set the costs other than ink and paper costs on the Others sheet.

Click Others tab to display it.
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Adding Other Unit Costs
1. Click the Add button.1.

The Add Other Unit Costs dialog box appears.

2. Set each item.2.

Set Name, Unit Costs, and Add to Tabulation.

3. Click the Start button.3.

The unit cost settings you added are added to the Unit Cost List.
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Editing Other Unit Costs
The procedure for editing other unit costs is shown below.

Editing the Unit Cost List in the List

1. Directly edit in list.1.

Edit Unit Costs and Allocate in Unit Cost List directly in list.

To enable editing, double-click the item to be edited.

2. Click the OK button.2.

When you finish editing, click OK button.

Editing with Edit Other Unit Cost Dialog Box

1. Click Edit button.1.

The Edit Other Unit Costs dialog box appears.

2. Edit.2.

Edit items to be changed.

3. Click the Update button.3.

When you finish editing, click Update button and close Edit screen.

4. Click the OK button.4.

Copying Unit Costs
Clicking the Copy Unit Cost button in the Unit Costs dialog box displays the Copy Unit Cost dialog box.

You can copy unit costs set on a printer to another printer.
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1. Select printer to copy from.1.

Select the printer from which the unit costs will be copied in Copy From.

2. Select printer to copy to.2.

Select the printer to be copied to in Copy To.

3. Select items to be copied.3.

Select the items to be copied in Category.

4. Click Start button.4.

Note
• For details on each item, see "Unit Costs Dialog Box."•
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Setting Units Displayed

Set the units displayed in Accounting Manager.

To open the Preferences dialog box, select Preferences in the Tools menu.

Setting Units
Set the units displayed in Accounting Manager on the Unit sheet in the Preferences dialog box.

Date Display Format
Use this option to select the display format for dates.

"YYYY" indicates the year, "MM" the month and "DD" the day.

Currency
Enter the currency unit.

Enter a text string up to 3 characters long.

1000 Separator
Use this option to select the symbol used as a separator in numbers.

The symbol is inserted every 3 digits.

Decimal Symbol
Use this option to select the symbol used as a decimal point.

Paper Height/Area
Select paper dimension specification from Single Specification, In metric units, or In US
customary units.
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Width
Use this to select the unit used for paper width.

Enabled when you select Single Specification in Paper Height/Area.

Height
Use this to select the unit used for paper length.

Enabled when you select Single Specification in Paper Height/Area.

Area
Use this to select the unit used for paper area.

Enabled when you select Single Specification in Paper Height/Area.
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Setting List Display

Configure settings related to Accounting Manager display.

To open the Preferences dialog box, select Preferences in the Tools menu.

Setting Category to Be Displayed
Set the items displayed in the Job Cost list on the main screen.

Configure the settings in Category to Be Displayed on the View sheet in the Preferences dialog box.

Print Jobs Shown Per Page
Specify the number of display items per page for job costs displayed in the Job Cost list.

Tabulation Period
Set the units for the tabulation period.

Tabulation Start Date
Set the tabulation start date for Tabulation Period.

Note
• You can display job logs for each period set in Tabulation Period and Tabulation Start Date.•

Category to Be Displayed
Specify the job log items to be displayed in job cost.
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Selected items appear in the Job Cost list on the main screen starting from the left according to the
list's sort order.
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Unregistering Managed Printer

Unregisters managed printers.

1. Click  Printer Management button or select Manage Printer from Printer of File1.
menu.

The Printer Management dialog box appears.

2. Select printer to unregister.2.

Select the printer you want to unregister from the printer list.

3. Click Remove button.3.

The Select Removal Method screen appears.

To keep the selected printer in the printer list even after it was unregistered, select the Keep this on the
printer list check box.

Note
• Job logs are not acquired from the printer after it is unregistered.•

• If you selected Keep this on the printer list, the printer remains in the printer list labeled•
as (removed). You can view job logs acquired prior to unregistration even after the printer is
unregistered.
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If it is not necessary to view the job logs, leave the Keep this on the printer list check box
cleared.

• To re-register a printer to be managed that was unregistered with the Keep this on the printer list•
setting, delete it from the list, and then re-register it.

To delete the managed printer from the printer list, open the Select Removal Method screen, and
clear the Keep this on the printer list check box.

4. Click Start.4.

The settings are applied to the printer list.

5. Click OK.5.

The selected printer is unregistered.

Note
• For details on the Printer Management dialog box, see "Printer Management Dialog Box."•
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Various Accounting Manager Features

 Filtering Settings

 Tabulating Costs

 Exporting Cost Tabulation Results to CSV File

 Exporting/Importing Job Logs as File

 Exporting Cost Information to a File
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Filtering Settings

You can display filtered items by configuring the Filter Job Logs.

1. Click Filter Job Logs on main screen.1.

The Filter Job Log dialog box appears.

2. Select objects to be displayed.2.

Select the items to be displayed in the Job Cost list on the main screen.

Specify a range for Printer, Period, and Account ID/Department (Account ID2)/Owner for each item.

3. Click OK.3.

The job log selected in the Job Cost list on the main screen appears.
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Tabulating Costs

You can specify the tabulation criteria and display the cost tabulation results in the Cost Tabulation dialog
box.

Click the  Cost Tabulation button or select Cost Tabulation in Job Cost from the File menu to open
the Cost Tabulation dialog box.

Setting Tabulation Criteria and Tabulating Cost

1. Specify tabulation criteria.1.

Specify the criteria for tabulation targets in Printer, Period, and Account ID/Department (Account
ID2)/Owner.

2. Click the Tabulate button.2.

The tabulation results for the specified criteria appear at the bottom of the Cost Tabulation dialog
box.

3. Export tabulation results to file.3.

Export the tabulation results to a file if necessary.

You can export the tabulation results to a CSV file by clicking the Export button.

Note
• If there is even one record for which a cost cannot be calculated, because the unit cost is not set,•

"Cannot calculate the values to be tabulated because a unit cost has not been set." appears.
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In this case, set the unit cost, and then tabulate the cost again.

Configure unit costs, including the costs of ink and paper

You can check the items without unit costs by clicking Unspecified Unit Cost.

• If an overflow of records for a tabulation target has occurred, "Cannot calculate the values to be•
tabulated because a unit cost has not been set." also appears.

Important
• If "Cannot calculate the values to be tabulated because a unit cost has not been set." appears•

because an overflow occurred in the records of the tabulation target, nothing appears in Unspecified
Unit Cost List.
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Exporting Cost Tabulation Results to CSV File

You can export cost tabulation results to a file in CSV format. You can use this file when you want to
perform detailed analysis using tools such as spreadsheet software.

You can export the cost tabulation results to a CSV file by clicking the Export button in the Cost Tabulation
dialog box.

Note
• You can select the items to export to a file in CSV format. For details, see "CSV Settings Dialog Box."

1. Open Cost Tabulation dialog box.1.

Select Cost Tabulation in Job Cost from the File menu to open the Cost Tabulation dialog box.

2. Set tabulation criteria.2.

Specify the Printer, Period, and Account ID/Department (Account ID2)/Owner for cost tabulation.

3. Click the Tabulate button.3.

The cost tabulation results appear.

Note
• Clicking the Cancel button in the progress screen that displays the processing progress cancels•

acquisition and tabulation and displays blank tabulation results.

• If there is even one record in the tabulation target for which a cost cannot be calculated, because•
the unit cost is not set, "Cannot calculate the values to be tabulated because a unit cost has
not been set." appears.
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• If an overflow of records for a tabulation target has occurred, "Cannot calculate the values to be•
tabulated because a unit cost has not been set." also appears.

4. Export cost tabulation results.4.

Click the Export button.

Specify a file name and destination, and then click the Save button.

You can export the tabulation results to a file in CSV format.

Note
• If the tabulation results do not appear, the Export button is disabled.•

64



Exporting/Importing Job Logs as File

You can export and import collected job logs as a file. This file can be used if you are replacing the
computer used for management, changing the job log destination, or increasing hard disk capacity.

Exporting Job Logs
You can export collected job information with the Export sheet in the Job Log Management dialog box.

1. Open Export sheet in Job Log Management dialog box.1.

Select Manage Job Logs from the File menu.

Click the Export tab in the Job Log Management dialog box.

2. Specify destination.2.

Specify the destination for the job logs in Destination.

3. Specify target printer.3.

Specify the printer for export in Target Printer.

Selecting All includes all managed printers.

Note
• Printers that were previously registered as managed printers but are no longer registered•

appear with their MAC addresses.

4. Specify target period.4.

Specify the Target Period.

5. Execute export.5.

Click the Start button.

65



Job logs are saved in the folder specified in Destination.

Importing Job Logs
You can import an exported job information file with the Import sheet in the Job Log Management dialog
box.

1. Open Import sheet in Job Log Management dialog box.1.

Select Manage Job Logs from the File menu.

Click the Import tab in the Job Log Management dialog box.

2. Specify file.2.

Specify the file to be imported in File.

Click the Browse button to open the dialog box for specifying a file.

3. Execute import.3.

Click the Start button.

The job log specified in File is imported.
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Exporting Cost Information to a File

Export cost information from acquired job data to a file in CSV format.

There are two ways to export cost information, as shown below.

• Export Cost Information of Selected Jobs•

• Export Cost Information at Scheduled Intervals•

Cost information that is exported at scheduled intervals is sent by email.

Important
• The scheduled export and email transmission of cost information requires that resident service be•

started.

For details on the resident service, see "Resident Service Settings Dialog Box."

Export Cost Information of Selected Jobs
Export cost information to a file in CSV format for jobs selected in the Job Cost list.

1. Select the record to be exported.1.

Select the record you want to export to a file from the list.

You can select multiple records.

2. Click the  Export Job Cost Data button.2.

Or select Export Job Cost Data from Job Cost in the File menu.

Specify the file name and export destination, and then click Save.

Export Cost Information at Scheduled Intervals
Cost information can be exported to a file in CSV format at scheduled intervals.

This applies to all printers for which job costs can be checked in Accounting Manager.

1. Open the Scheduled Export of Cost Data dialog box.1.

Select Scheduled Export of Cost Data from Job Cost in the File menu.

2. Specify the export criteria.2.

Specify the Date and Destination, and then click the OK button.

Select Output tabulated results to a file for each category to output a file in which each item is
totaled. In Tabulation Settings, select the items to be totaled and tabulated.
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The scheduled export of cost information will be performed using the specified criteria.

Note
• For details on the scheduled export of cost information, see "Scheduled Export of Cost

Information Dialog Box."
• You can select the items to export to a file in CSV format. For details, see "CSV Settings Dialog

Box."

Sending Cost Information by Email
Cost information files that are exported at scheduled intervals are sent in a CSV format by email.

The CSV format files that are exported at scheduled intervals are attached to an email and sent to
specified addresses.

Important
• In order to send emails successfully, you may need to do settings to your anti-virus software.•

• In Accounting Manager, "cnwaammailer.exe" is executed to send emails. If the anti-virus software is•
blocking emails from being sent, register "cnwaammailer.exe" as an excluded application.

• For instructions on registering files as excluded applications, check the documentation for the anti-•
virus software you are using.

1. Set the send email function.1.
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Select Send exported files by email in the Scheduled Export of Cost Data dialog box.

Select All to attach a CSV file that is exported at scheduled intervals and a CSV file in which each
item is totaled.

Select Tabulated results only to attach only a CSV file in which each item is totaled.

2. Open Email Settings dialog box.2.

Click the Email Settings button.

3. Set the email to send and the email server.3.

Do the settings to send emails.
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Note
• For details about email settings, see "Email Settings dialog box."
• When you want to confirm that email can be sent correctly using the set conditions, click Send

Test Mail. This sends a test email.

When you have completed the settings, click the OK button to close the Email Settings dialog box.

4. Click the OK button.4.

The settings are reflected and the Scheduled Export of Cost Data dialog box closes.
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Displaying Various Information

 Checking Unit Costs Set on Printer

 Checking Consumption

 Checking Errors During Job Log Acquisition

 Checking the Status of the Scheduled Export of Cost Information
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Checking Unit Costs Set on Printer

You can display a list of unit costs set for the selected printer in the Specified Unit Cost dialog box.

1. Select printer whose unit costs will be checked.1.

2. Display Specified Unit Cost dialog box.2.

Select Specified Unit Cost in Job Cost from the File menu.

The Specified Unit Cost dialog box appears.

Note
• For details on Specified Unit Cost, see "Specified Unit Cost Dialog Box."•
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Checking Consumption

You can check the ink and paper consumed for each printer or for each job.

Checking Ink and Paper Consumed Per Printer
You can check the consumed ink and paper up to present for the selected printer in the Ink and Paper
Consumed dialog box.

Note
• For details, see "Ink and Paper Consumed Dialog Box."•

Checking Consumption Per Job
The Job Properties dialog box displays detailed information about the selected job, including cost
information.

Note
• For details, see "Job Properties Dialog Box."•
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Checking Errors During Job Log Acquisition

Errors that occur during job log acquisition can be displayed on the Job Log Acquisition Status sheet in
the Check Operation Status dialog box.

Click Check Operation Status in the Tools menu to display.

Note
• For details, see "Check Operation Status Dialog Box."•
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Checking the Status of the Scheduled Export of Cost
Information

You can check the operation status for scheduled exports of job cost data and email transmissions.

To display the status of the scheduled export of cost information, click Check Operation Status in the
Tools menu to open the Check Operation Status dialog box, and then click the Scheduled Export of
Cost Data tab.

Note
• For details, see "Check Operation Status Dialog Box."•
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Description of Accounting Manager Screen

 Main Window

 Filter Job Log Dialog Box

 Cost Tabulation Dialog Box

 Specified Unit Cost Dialog Box

 Ink and Paper Consumed Dialog Box

 Job Properties Dialog Box

 Unit Costs Dialog Box

 Resident Service Settings Dialog Box

 Printer Management Dialog Box

 Check Operation Status Dialog Box

 Preferences Dialog Box

 Job Log Management Dialog Box

 Scheduled Export of Cost Data Dialog Box

CSV Settings Dialog Box
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Main Window

The Accounting Manager main screen consists of the title bar, main menu (toolbars), job cost list area,
printer list area, status bar, and target period and filtering button area.

(1) Toolbars

(2) Printer List Area

(3) Target Period/Filtering Button Area

(4) Job Cost List Area

(5) Status Bar

Main Menu (Menu Bar)

(1) Toolbars
The toolbars include the Standard toolbar and the Navigation toolbar.

You can opt to either show or hide the toolbars with Toolbars in the View menu.

Standard Toolbar
Execute buttons for most frequently used features are located here.

•  Printer Management button•

The Printer Management Dialog Box appears.

Register and unregister managed printers and change their settings.
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•  Unit Costs button•

The Unit Costs Dialog Box appears.

Set unit costs for ink, paper, and other unit costs.

Enabled when the target printer is selected in printer list.

•  Export Job Cost Data button•

Export the selected job cost information to a CSV file.

Enabled when job cost is selected in the Job Cost list.

•  Cost Tabulation button•

The Cost Tabulation Dialog Box appears.

Specify the criteria and tabulate cost.

•  Refresh button•

Acquire and display the latest job logs.

•  Help button•

Display the Help.

Navigation Toolbar
Features related to page navigation are located here.

•  Show First Page button•

Go to the first page.

Several pages comprise the Job Cost list and this button is enabled except on the first page.

•  Show Previous Page button•

Go to the previous page.

Several pages comprise the Job Cost list and this button is enabled except on the first page.

•  Show Next Page button•

Go to the next page.

Several pages comprise the Job Cost list and this button is enabled except on the last page.

•  Show Last Page button•

Go to last page.

Several pages comprise the Job Cost list and this button is enabled except on the last page.

(2) Printer List Area
A list of printers registered as currently managed printers appears.
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(3) Target Period/Filtering Button Area

Target Period
Target Period displays the current display criteria for the Job Cost list.

Configure the period in Filter Job Log.

Note
• If the specified target period is a consecutive period, this period appears.•
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If non-consecutive periods are specified, the period appears with an * (asterisk) appended to the
end.

Filter Job Logs button
Click the Filter Job Log button to display the Filter Job Log Dialog Box.

Filter Job Log dialog box
Select the items to be displayed in the Job Cost list on the main screen.

Specify a range for Printer, Period, and Account ID/Department (Account ID2)/Owner for
each item.
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(4) Job Cost List Area
Items including Cost, Account ID, Document Name, Printing Results, Media Type, and Paper
Consumed appear.

Cost
The cost of printing.

• Total cost of job: (ink + paper + other costs)•

If the cost cannot be calculated because the ink and paper unit costs have not be set, *** appears.

Printer Name
The name of the printer that printed the job appears.

Account ID
The Account ID set for the job appears.

Important
• When a user (the person printing) sends a job to the printer, they must include identifying•

information connected to the person who sent the job (Account ID, Department (Account ID2), or
Owner).

For details, see the User Manual for your model from the Home of the Online Manual.

Document Name
This is the name of the printed document.

Printing Results
The printing results for the job appears.

Displays Complete if the printing is executed, Canceled if the printing is not executed, Error if an
error occurs, and Warning if an error occurs in the print job data.
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Media Type
This is the type of paper used in printing.

The paper name based on the information acquired from the printer appears.

Note
• Displays Unknown Paper if the relevant paper name cannot be acquired.•

Printer Paper Size
Size indicating the print area of the job.

Paper Consumed
This is the area of paper used in printing.

Paper Width
This is the width of paper used in printing.

Paper Height
This is the length of paper used in printing.

Ink Consumed
Amount of ink used in printing (total consumption for each color).

Owner
The sender (owner's name) of the job.

The user name of the user logged into the OS is assigned.

Print Job Start Time
Time printing started.

The Print Job Start Time that will appear in the Job Cost list is as follows:

When Time Zone Set on Printer
Displays the time converted from the time zone set on the computer running Accounting
Manager.

When Time Zone Not Set on Printer
Displays the time in the time zone set on the computer running Accounting Manager.

Print Time
Time it took to print the job.

Pages
The number of pages printed.

The number of impressions (number of surfaces) for the job appears.

For a job where 3 copies of a 2-page original are printed, it is "6".

Print Quality
Level of print quality for the job.

Paper Cost
The cost of paper used for printing.

Total Ink Cost
Total cost of ink used in printing (total ink cost for each color).
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Total of Other Costs
The total value of costs other than paper and ink.

Ink Cost Details
The cost per color of ink appears.

Ink Consumption Details
The amount of each color of ink used.

job_description
The ID set for the job appears.

Print Priority
The Print Priority settings selected when printing appear.

Paper Source
The Paper Source when printing appears.

Department (Account ID2)
Displays the Account ID2 specified in the job.

Project number
Displays the project number specified in the job.

Order number
Displays the order number specified in the job.

Customer ID
Displays the customer ID specified in the job.

Job number
Displays the job number specified in the job.

Comment
Displays comments specified in the job.

Note
• The items shown vary depending on your model.•

• In the Preferences Dialog Box, set the number of jobs, items, and sort order displayed in the Job Cost•
list.

• If all of the jobs extracted based on the filtering criteria do not fill up the configured number of jobs,•
they all appear on one page. The most recent job logs on the first page appears if the configured
number of jobs is exceeded. The portion exceeding the configured number of jobs appears on the
second and subsequent pages.

• If overflow occurs in the calculation results, --- appears.•

(5) Status Bar
Messages including notifications that job log acquisition errors have occurred, descriptions of functions,
job selection status, and last update date/time appear.
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Main Menu (Menu Bar)
Select the menu items for the necessary operations.

File Menu
View Menu
Tools Menu
Help Menu

File Menu

Printer

Manage Printer
The Printer Management Dialog Box appears.

Register and unregister managed printers, and change settings for managed printers in the
Printer Management dialog box.

Also, you can import and export managed printers.

Ink and Paper Consumed
The Ink and Paper Consumed Dialog Box appears.

You can check the ink and paper consumed up to the present for this printer.

Enabled if a printer is selected in the printer list.

Job Cost

Cost Tabulation
The Cost Tabulation Dialog Box appears.

You can specify tabulation criteria and tabulate costs here.
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Export Job Cost Data
Export cost information in CVS format for jobs selected in the Job Cost list on the main screen.

Enabled when a job is selected in the Job Cost list.

Scheduled Export of Cost Data
Displays the Scheduled Export of Cost Data Dialog Box.

Exports cost information of jobs in CSV format at scheduled intervals and sends it by email.

This applies to all printers for which job costs can be checked in Accounting Manager.

Unit Costs
Displays the Unit Costs Dialog Box for the printer of the job selected in the Job Cost list on the
main screen.

Enabled if a printer is selected in the printer list.

Specified Unit Cost
The Specified Unit Cost Dialog Box appears.

You can check the list of unit costs set on the printer here.

Enabled if a printer is selected in the printer list.

Manage Job Logs
The Job Log Management Dialog Box appears.

Execute operations related to job logs (import, export, move, and delete).

Exit
Close the main window and exit Accounting Manager.

Note
• If Start is set in Resident Service Settings, job logs are acquired regularly in the background•

even after exiting.

View Menu
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Toolbars

Show or hide Toolbars.

Toolbars include the Standard Toolbar and Navigation Toolbar, and you can show and hide each
toolbar.

Status Bar
Show or hide Status Bar.

Messages including notification for job log acquisition errors settings, descriptions of functions, job
selection status, and last update date/time appear.

Go

Navigate between pages.

Choose from the following methods of navigation.

• Show First Page•

Several pages comprise the Job Cost list and this button is enabled except on the first page.

• Show Previous Page•

Several pages comprise the Job Cost list and this button is enabled except on the first page.

• Show Next Page•

Several pages comprise the Job Cost list and this button is enabled except on the last page.

• Show Last Page•

Several pages comprise the Job Cost list and this button is enabled except on the last page.

Job Properties
The Job Properties Dialog Box appears.

You can check detailed information for job costs.

Enabled when a job is selected in the Job Cost list.

Filter Job Logs
The Filter Job Log Dialog Box appears.
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Select the items to be displayed in the Job Cost list.

Refresh
Acquires and displays the latest job logs.

Acquires the most recent job logs from printers specified in the extraction criteria to update the Job
Cost list.

Tools Menu

Resident Service Control
The Resident Service Settings Dialog Box appears.

Displays the operating status of the resident service, and controls the start and stop of the resident
service.

Check Operation Status
Displays the Check Operation Status Dialog Box.

Displays a list of errors that occurred when acquiring job logs from the printer and the operation
status of scheduled export and transmission by email of job cost data.

CSV Settings
Displays the CSV Settings Dialog Box.

Set the items to export to a file in CSV format.

Preferences
The Preferences Dialog Box appears.

Specify your preferences (settings related to displayed content and displayed items) for Accounting
Manager.

Help Menu

Instructions
Displays the Accounting Manager guide.

Disclaimer
Displays a disclaimer.
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Filter Job Log Dialog Box

Select Filter Job Logs from the View menu to open the Filter Job Log dialog box.

Printer
Displays the list of All printers or printers registered as managed printers in the Printer Management
dialog box.

Period
Displays a period list created based on All or Tabulation Period and Tabulation Start Date settings and
the print date for the oldest record among the job logs saved to the local database.

Account ID/Department (Account ID2)/Owner
In the drop-down menu, specify either Account ID, Department (Account ID2), or Owner as extraction
criteria.

The Account ID, Department (Account ID2), or Owner list will appear, including an All option, as well
as all printers and job logs saved to the local database.
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Cost Tabulation Dialog Box

Select Cost Tabulation in Job Cost from the File menu to open the Cost Tabulation dialog box.

You can specify tabulation criteria and tabulate costs.

Printer
All and the list of printers registered as managed printers in the Printer Management dialog box are
displayed.

Period
Displays a period list created based on All or Tabulation Period and Tabulation Start Date settings and
the print date for the oldest record among the job logs saved to the local database.

Account ID/Department (Account ID2)/Owner
In the drop-down menu, specify either Account ID, Department (Account ID2), or Owner as extraction
criteria.

The Account ID, Department (Account ID2), or Owner list will appear, including an All option, as well
as all printers and job logs saved to the local database.

Total Job Cost
The total costs for extracted jobs appears.

*** appears if jobs for which the cost cannot be calculated because the unit cost is not set are included
in the target jobs.

Number of Target Jobs
The total number of extracted jobs appears.

Total Ink Cost
The total ink costs for extracted jobs appears.
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*** appears if jobs for which the cost cannot be calculated because the unit cost is not set are included
in the target jobs.

Total Ink Consumed
The total ink consumed for extracted jobs appears.

Total Paper Cost
The total paper costs for extracted jobs appears.

*** appears if jobs for which the cost cannot be calculated because the unit cost is not set are included
in the target jobs.

Total Paper Consumed
The total paper consumed for extracted jobs appears.

Total of Other Costs
The total costs other than ink and paper for extracted jobs appears.

Export button
Exports the tabulation results and the job cost records of the extracted jobs in CSV format.

Enabled if tabulation results exist.

Unspecified Unit Cost button
Calculates costs according to extraction criteria and lists unit costs with inadequate settings.

Job logs are not acquired from the printer at this time.

The list of unspecified unit costs appear in the Unspecified Unit Cost Dialog Box.

Tabulate button
Tabulates costs.

To acquire job logs from the target printers, click the Tabulate button.

Extracts job logs, calculates costs, and displays tabulation results when job log acquisition from all
target printers is completed.

Note
• Clicking the Cancel button in the progress screen that displays the processing progress cancels•

acquisition and tabulation and displays blank tabulation results.

• If there is even one record in the tabulation target for which a cost cannot be calculated, because•
the unit cost is not set, "Cannot calculate the values to be tabulated because a unit cost has
not been set." appears.

• If an overflow of records for a tabulation target has occurred, "Cannot calculate the values to be•
tabulated because a unit cost has not been set." also appears.

Note
• If overflow occurs in the calculation results, --- appears.•

• If --- appears, check the unit costs and tabulation period settings are appropriate.•
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Unspecified Unit Cost Dialog Box
When the job cost calculation is performed using the criteria specified in the Tabulate screen, inadequate
unit cost settings are extracted and appear in the Unspecified Unit Cost dialog box.

Unspecified Unit Cost List
Printer

The printer name appears.

Item
Ink or Paper appears.

Details
The details for target items appear.

Important
• If "Cannot calculate the values to be tabulated because a unit cost has not been set." appears•

because an overflow occurred in the records of the tabulation target, nothing appears in Unspecified
Unit Cost List.
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Specified Unit Cost Dialog Box

You can check a list of unit costs set for this printer in the Specified Unit Cost dialog box.

Select Specified Unit Cost in Job Cost from the File menu to open the Specified Unit Cost dialog box.

Specified Unit Cost List
Item

The item names of unit cost settings specified for Ink, Paper, and Others appear.

Details
The details for items appear.

Unit Costs
The unit costs set for items appear.

Allocate
Yes appears when the set unit cost is used in job cost calculation.

Items that are not used are blank.
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Ink and Paper Consumed Dialog Box

You can check the ink and paper up consumed to the present for this printer in the Ink and Paper
Consumed dialog box.

To display the dialog box, click Ink and Paper Consumed from Printer in the File menu.

Ink and Paper Consumption List
Item

Item names appear.

Value
For ink

• Ink consumed based on the units settings appear.•

For paper

• The print area consumed for paper appear based on the units settings.•

• The number of sheets printed in A4 appears.•
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Job Properties Dialog Box

The Job Properties dialog box displays detailed information about the selected job.

To open the Job Properties dialog box, from the View menu, select Job Properties or press Enter on the
keyboard.

Additionally, you can open it by double-clicking a job in the Job Cost list that you want to check the
properties of.

Document Name
The name of the job appears.

Printer
The name of the printer that printed the job appear.

Printing Results
The printing results for the job appears.

Owner
The name of the owner of the job appear.
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Account ID
The Account ID for the job appears.

Department (Account ID2)
The Account ID2 for the job will appear here.

Print Job Start Time
The print start time for the job appears.

The Print Job Start Time that will appear is as follows:

When Time Zone Set on Printer
Displays the time converted from the time zone set on the computer running Accounting Manager.

When Time Zone Not Set on Printer
Displays the time in the time zone set on the computer running Accounting Manager.

Print Time
The print time for the job appears.

Calculates the print time based on the print start time and the print completion time included in the job
cost.

Pages
The number of pages for the job appears.

Print Quality
The level of print quality for the job appears.

Output Image Size
The output image size for the job appears.

Displayed according to unit cost settings based on the logical paper size included in the job cost.

Total Job Cost
The total costs for target jobs appear.

*** appears if jobs for which the cost cannot be calculated because the unit cost is not set are included
in the target jobs.

Total Paper Cost
The total paper costs for target jobs appear.

*** appears if jobs for which the cost cannot be calculated because the unit cost is not set are included
in the target jobs.

Total Ink Cost
The total ink costs for target jobs appear.

*** appears if jobs for which the cost cannot be calculated because the unit cost is not set are included
in the target jobs.

Total of Other Costs
The total value of other costs for target jobs appears.

Total Ink Consumed
The total value of ink consumed for target jobs appears.

Total Paper Consumed [Area]
The total value of paper consumed for target jobs appears.
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Total Sheets of Paper Consumed [Converted to A4 Size]
Calculates the A4 conversion value from the total value of the area of paper consumed for target jobs.

Paper Width
The width of the paper used by the job appears.

Displays the logical paper width information and the width information for paper used, according to the
unit settings based on the information acquired from the printer.

Paper Height
The length of the paper used by the job appears.

The cut sheet length information and the width information for paper used appears according to the unit
settings based on the information acquired from the printer.

Job Cost and Consumption Details
The cost and total consumption per ink color and per media type appear.

Item
The ink color and paper name appear.

Amount Consumed
The total consumption per item appears.

*** appears if jobs for which the cost cannot be calculated because the unit cost is not set are
included in the target jobs.

Cost
The total costs for each item appear.

*** appears if jobs for which the cost cannot be calculated because the unit cost is not set are
included in the target jobs.

Note
• If overflow occurs in the calculation results, --- appears.•

• If --- appears, check the unit costs and tabulation period settings are appropriate.•
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Unit Costs Dialog Box

Set the unit costs used to calculate job cost in the Unit Costs dialog box. Set the unit costs for ink, paper,
and items other than ink and paper.

Select Unit Costs in Job Cost from the File menu to open the Unit Costs dialog box.

The Unit Costs dialog box consists of the following sheets.

Ink sheet
Paper sheet
Others sheet
Common to All Sheets

Ink sheet

Ink Color
Ink Color and an icon indicating the ink color appear.

The ink list that appears is acquired from the selected printer.

Ink Tank Capacity
The ink tank capacity appears according to the units setting.
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Unit Costs
The unit costs for Ink Color and Ink Tank Capacity appear.

If the unit costs are not set, Not set appears.

To change the unit costs settings, edit the list directly.

Apply to All Inks button
Applies the currently selected Unit Costs and Ink Tank Capacity in Ink Color to all ink colors
displayed in Unit Cost List.

Disabled if one ink or less is displayed in Unit Cost List or no ink has been selected.

Paper sheet

Media Type
The paper name appears.

The name that appeared in the printer driver is applied.

Size
General Purpose, Regular Size Name, or Roll Paper Width Name appears.

Width
The paper width appears according to the units setting.
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You can edit the list directly if Size is General Purpose.

Height
The paper length appears according to the units setting.

You can edit the list directly if Size is General Purpose or Roll Paper Width Name.

Number of Sheets/Rolls
The number of sheets in a package appears when the price per paper package is set.

If you select Roll Paper, the number of rolls appears.

Unit Costs
The price per paper package appears.

The unit cost settings you added are added to the Unit Cost List.

Add button
Adds a new unit cost setting for paper.

The unit cost settings you added are added to Unit Cost List.

For details on Add Paper Unit Cost, see "Add Paper Unit Cost Dialog Box."

Edit button
Enables editing of the unit cost settings for paper.

Delete button
Deletes the selected paper unit costs.

Deleted paper unit costs are deleted from Unit Cost List.
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Others sheet

Item
Item names set for unit costs appear.

Unit Costs
The unit costs for item names appear.

Allocate
Yes or No appears for whether to include this unit cost setting when calculating job costs.

To change the settings, change them directly in the list.

Add button
Adds a new other unit cost setting.

The unit cost settings you added are added to the Unit Cost List.

Edit button
Enables editing of the settings for this unit cost.

Delete button
Deletes the selected unit cost settings.

Deleted unit cost settings are deleted from Unit Cost List.
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Common to All Sheets
Import button

Imports unit cost settings.

Export button
Exports unit cost settings.

Copy Unit Cost button
Copies unit costs.

For details on Copy Unit Cost, see "Copy Unit Cost Dialog Box."

Acquire Printer Information button
Acquires printer information.

OK button
Saves changes to the unit cost settings and closes the Unit Costs dialog box.

Cancel button
Discards changes and closes the Unit Costs dialog box.

Add Paper Unit Cost Dialog Box
Adds a new unit cost setting for paper.

Media Type
Specify the Media Type.

A list of the media types supported by the target printer appears.

Other Media
To set a unit cost for a paper not displayed in Media Type, select Other Media and enter the
paper ID.

101



You can check the paper ID on the Unspecified Unit Cost screen or in Unit Cost List on the
Paper tab of the Unit Costs screen.

"Unknown Paper [Paper ID]" appears for paper not appearing in Media Type, so enter this
paper ID.

Paper Size
Set the size type for the paper.

Select General Purpose, Roll Paper, or Cut Sheet for the size type.

Width
Specify the paper width.

If Roll Paper or Cut Sheet is selected in Paper Size, it is entered automatically.

Note
• If you have specified a custom size roll width in the printer driver, select Paper Size > Roll•

Paper > User-defined, and then input the same value as has been set for Width in the
printer driver.

Height
Specify the paper length.

If Cut Sheet is selected in Paper Size, it is entered automatically.

Number of Sheets/Rolls
Specify the count per paper package (number of sheets).

If Roll Paper is selected in Paper Size, specify the number of rolls.

Unit Costs
Enter the price per paper package.

Copy Unit Cost Dialog Box
Specifies the printer and items, and copies the unit cost settings.
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Copy From
From the list of registered printers (same printers as displayed in the printer list on the main screen),
select the printer to copy from.

Copy To
Select the printer to copy to.

Category
Select the items to be copied.

You can select Ink, Paper, and Others individually.

Note
• If you copy unit costs, all the unit cost settings on the printer copied to will be overwritten with the unit•

cost settings on the printer copied from.
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Resident Service Settings Dialog Box

You can display the operating status of the resident service, and control the start and stop of the resident
service in the Resident Service Settings.

To open the Resident Service Settings dialog box, select Resident Service Control in the Tools menu.

While the Resident Service Settings is shown, the status of the resident service is acquired regularly, and
the display is updated.

Start button
Starts the resident service.

The resident service starts automatically when the operating system is started.

Stop button
Stops the resident service.

Important
• Resident service is set to Start when Accounting Manager is installed.•

If you Stop the resident service, functions performed periodically, such as the periodic acquisition
of job logs and the scheduled export of cost information, will be disabled.

As a result, you may no longer be able to acquire all the job logs for jobs printed on the printer.
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Printer Management Dialog Box

You can register and unregister managed printers.

You can also change settings, and export and import information for managed printers.

Printer Management Dialog Box

Click the  Printer Management button or select Manage Printer in Printer from the File menu to
open the Printer Management dialog box.

Printer List
Displays the list of managed printers.

Printer Name
The printer name appears.

Connection
The found printer address information (connection) appears.

The printer's IP address appears for IPv4 and IPv6 connections, and the connection port name
appears for USB-connected printers.

Scheduled Acquisition
ON appears for printers performing scheduled acquisition and OFF appears for printers not
performing scheduled acquisition.

Status
Information about the printers found appears.

Add Printer button
The Add PrinterDialog Box appears.

Printers added in the Add Printer dialog box appear in the printer list.

Remove button
The selected printer is removed (unregistered) from the managed printers.
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You can also leave unregistered printers in the printer list and continue to check job costs.

Disabled if no printers are selected or if multiple printers are selected.

Advanced Settings button
The Advanced Printer Settings Dialog Box appears.

You can check and change Printer Name, check Serial Number, check Scheduled Acquisition
Settings, set Authentication Password, and perform Auth. Test.

Disabled if no printers are selected or if multiple printers are selected.

Import button
Imports the managed printer(s) from a file.

The managed printers that are imported in Printer List appears.

Note
• When you click the Import button to import a file, the Select Printer screen will appear. Printers•

with connection methods that are not supported by Windows will not appear in the Printer List
on the Select Printer screen.

Example: Printers connected by Bonjour registered with the Mac version

Export button
Exports the managed printers displayed in Printer List to a file.

Note
• The print list to be exported does not include the authentication password used at the time of job•

log acquisition.

After importing, an authentication password must be set.

• A printer connected by USB cannot be exported.•

Add PrinterDialog Box
Search for printers to be registered in the printer list on the main screen, and register managed printers.

Click Add Printer button on Printer Management dialog box to display Add Printer dialog box.
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Search Method
Select the printer search method.

IP Address
Enter an IP address.

Disabled if something other than IPv4 or IPv6 is selected in Search Method.

Search button
Searches for printers using the selected Search Method.

Printer List
A list of printers found appears.

Printer
The model names of the printers found appears.

Serial Number
The serial numbers of printers found appear.

Connection
The found printer address information (connection) appears.

The printer's IP address appears for IPv4 and IPv6 connections, and the USB port name
appears for USB-connected printers.

Stop Searching button
Click to stop the search.

The search stops after waiting until the information acquisition is completed for printers that have
been found already.
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Search Options Button
Opens the Search Options dialog box.

Configure this when searching by SNMP Community.

Add button
Closes the Add Printer dialog box.

Printers selected in the printer list appear in Printer List of the Printer Management dialog box as
managed printers.

Advanced Printer Settings Dialog Box
You can configure advance settings for managed printers.

Printer Name
Specify the printer's display name in Accounting Manager.

Serial Number
The serial numbers of printers appear.

Scheduled Acquisition Settings
Set whether to perform scheduled acquisition of job logs.

To stop regular acquisition of job logs, clear the Run scheduled job log acquisition option.

Important
• Scheduled acquisition settings are enabled when the printer is registered. Job logs cannot be•

collected if the scheduled acquisition settings are disabled.

Authentication
Set an authentication password for job log acquisition.

Note
• Enter the password set for the printer.•
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• For details, search for and refer to the "Administrator Password" page from the home page of the•
Online Manual for your model.

Important
• If the job history is set to hide on the printer control panel, authentication information is required•

when acquiring job logs.

Auth. Test button
To perform an authentication test for job log acquisition, enter the Password and click the Auth. Test
button.

The authentication test results for job log acquisition appear in a message dialog box.

Add button
Changes the settings for the managed printer, and then closes the Advanced Printer Settings
dialog box.
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Check Operation Status Dialog Box

Select Check Operation Status from the Tools menu to display.

A list of errors that occurred when acquiring job logs will appear on the Job Log Acquisition Status sheet.

The operation status of scheduled job cost data exports and email transmissions are shown on the
Scheduled Export of Cost Data sheet.

Job Log Acquisition Status Sheet

Operation Status
The acquisition status in a list appear.

Printer
The printer name appears.

Time of Error
The time the error occurred appears according the display format setting.

If the same error occurred multiple times, displays the time the error last occurred.

Details
A description of the error appears.

Note
• The numbers that appear at the end of Details are added for internal identification in the•

software.

Confirm button
Errors currently shown do not appear in the future.
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Scheduled Export of Cost Data Sheet

Operation Status
Displays the status of scheduled exports in a list.

Time
Displays the time that each scheduled export of cost information was performed and the time
that the email was sent.

Details
Displays the results of the scheduled exports and the email transmissions.

Confirm button
The results currently being displayed will no longer appear on the list.
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Preferences Dialog Box

Specify your preferences (settings related to displayed content and displayed items) for Accounting
Manager.

This dialog box consists of the View, Unit, and Others sheets.

To display, select Preferences from the Tools menu.

View sheet

Print Jobs Shown Per Page
Specify the number of display items per page for job costs displayed in the list.

Tabulation Period
Set the units for the tabulation period.

Tabulation Start Date
Specify the tabulation start date for Tabulation Period.

The items that can be specified correspond to the items set in Tabulation Period and change
dynamically.

Note
• If you specified Annually, "1-12" (January to December) is listed.•

Category to Be Displayed
Specify the job log items to be displayed in job cost.

112



Selected items appear in the list on the main screen according to the list's sort order.

Up button
Moves up the selected item one row.

Down button
Moves down the selected item one row.

Unit sheet

Date Display Format
Use this option to select the display format for dates.

"YYYY" indicates the year, "MM" the month and "DD" the day.

Currency
Enter the currency unit.

Enter a text string up to 3 characters long for the currency unit.

1000 Separator
Use this option to select the symbol used as a separator in numbers.

Decimal Symbol
Use this option to select the symbol used as a decimal point.

Paper Height/Area
Select how to specify the paper dimensions.

Select Single Specification to specify the units for Width, Height, and Area.

Select In metric units to display units in mm for Width, m for Height, and square meter for Area.
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Select In US customary units to display units in inch for Width, ft. for Height, and square feet for
Area.

Note
• The unit for Height will appear as mm when you select In metric units and as inch when you•

select In US customary units in all dialog boxes other than the Unit Costs dialog box and
Specified Unit Cost dialog box.

Width
Use this to select the unit used for paper width.

Enabled when you select Single Specification in Paper Height/Area.

Height
Use this to select the unit used for paper length.

Enabled when you select Single Specification in Paper Height/Area.

Area
Use this to select the unit used for paper area.

Enabled when you select Single Specification in Paper Height/Area.

Others sheet

Notification for Job Log Acquisition Error
Select whether a notification appears on the main screen when a job log acquisition error occurs.

• Selected: Notify•
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• Not selected: Do not notify•

Language Settings
Select the display language for Accounting Manager.

Important
• Changes to the display language are applied the next time Accounting Manager is started.•

Import button
Imports preferences.

Information that can be set in Preferences is imported.

Export button
Exports preferences.

Information that can be set in Preferences is imported.
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Job Log Management Dialog Box

Executes operations related to job logs (Import, Export, Move, and Delete).

This dialog box is used if you are replacing the computer used for management, changing the job log
destination, or increasing hard disk capacity.

To display, select Job Log Management from the File menu.

Import sheet
Imports job logs.

File
Specify the file to be imported.

Browse button
A dialog box for specifying a file appears.

Start button
The job log specified in File is imported.

Export sheet
Exports job logs. Exports the collected job information to a file.
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Destination
Specify an export destination.

Browse button
A dialog box for specifying a file appears.

Target Printer
Select the printer for export.

Note
• Previously managed printers that have been unregistered appear with their MAC addresses.•

Target Period
Specify an export target period.

Start button
Exports the job logs to the specified destination.

Move sheet
Changes the location where job logs are saved.
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Save Location
Specify the location where job logs are saved (move destination).

Browse button
Specify the move destination path (folder) with the dialog box.

Default Button
Restores the default value for Save Location.

Start button
Moves the job logs to the specified location (move destination).

Delete sheet
Deletes the job logs.

Target Printer
Select the printer for which job logs are deleted.
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Note
• Previously managed printers that have been unregistered appear with their MAC addresses.•

Target Period
Specify the period for deletion.

Start button
Deletes the job logs that meet the specified criteria.
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Scheduled Export of Cost Data Dialog Box

Configure the scheduled export of cost information to a file in CSV format.

You can also do the settings to send exported CSV format files by email.

This will show all printers for which job costs can be checked in Accounting Manager.

Select Scheduled Export of Cost Data from Job Cost in the File menu to display this dialog box.

Date
Specify the interval for performing the scheduled export of cost information.

Select from None, Daily, Weekly on, and Monthly on.

Note
• If None is selected, the scheduled export of cost information will not be performed.•

• To create exports at the end of each month, select Monthly on and specify 31 as the date to be•
performed.

Destination
Specify the folder that the cost information is exported to.

Files will be exported with a name in the following format: JobCostList_YYYYMMDD-YYYYMMDD.csv.
"YYYY" indicates the year, "MM" the month and "DD" the day.
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If a file with the same name already exists, "(n)" is appended to the end of the file name, so that a file
with a duplicate name is not exported.

Default Button
Restores the default value for Destination.

Output tabulated results to a file for each category
Selecting this also outputs a CSV-format file in which each item is tabulated.

Tabulation Settings
Click this to display the Tabulation Settings dialog box.

Each selected item is totaled and output as a tabulated file in CSV format.

Retry failed operations
Check this check box to try creating a schedule again after the export could not be completed for some
reason.

Send exported files by email
By selecting this, you can send cost information files that are exported at scheduled intervals in a CSV
format by email.

All
Attaches a CSV-format file that is exported at scheduled intervals and a CSV-format file in which
each item is totaled.

Tabulated results only
Only attaches a CSV-format file in which each item is totaled.

Email Settings
Displays the "Email Settings Dialog Box".

Do the settings related to the email server and the emails for sending cost information files that are
exported in a CSV format.

Important
• The scheduled export and email transmission of cost information requires that resident service be•

started.

For details on the resident service, see "Resident Service Settings Dialog Box."
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• Even if there are no jobs to be included in the exported log, a file will be exported. In this case, only the•
header row is exported.

Email Settings Dialog Box
Do the settings related to the email server and the emails for sending cost information files that are
exported in a CSV format.

Clicking the Email Settings button in the Scheduled Export of Cost Data dialog box opens the Email
Settings dialog box.

Email
To Address

Input the email addresses to which to send email. You can register up to a maximum of 5 email
addresses.

If you input multiple email addresses, separate them with commas ",".

From Address
Input the email address from which to send email. You can register 1 email address.
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Size Limit
Input the maximum size for attached files.

The emails are not sent if the size of the attached file is larger than the value that is input here.

Note
• The default value is 5120 (KB), you can input a value in a range from 5 to 102400 (KB).

Add Comment to Email
Input text as the body of the email. You can input a maximum of 80 characters.

Mail Server
SMTP Server

Input the IP address and the host name of the SMTP server.

Port Number
Input the port number of the SMTP server.

Secure connection (SSL/TLS)
Select this to use SSL/TLS to secure connections.

Do not verify certificates
Select this to not verify certificates on a secure connection.

Important
• You may need to install a certificate to use secure connections.•

Note the following precautions when installing a certificate.

In the import wizard for certificates, select your local computer as the location to store
the certificate.

In the import wizard for certificates, select Trusted Root Certificate Authorities as the
certificate store.

If you cannot select a storage location in the import wizard for certificates, use the
Microsoft Management Console (MMC) to change to a local computer.

SMTP Authentication
Select whether to use the SMTP server's authentication function. Select this to use the SMTP
server's authentication function.

Account
Input the account that uses SMTP authentication.

Password
Input the password that is used for SMTP authentication.

POP before SMTP
Select whether to use POP before SMTP. Select this to use POP before SMTP.

POP Server
Input the IP address and the host name of the POP server.

Port Number
Input the port number of the POP server.
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Account
Input the account used when connecting to the POP server.

Password
Input the password used when connecting to the POP server.

Wait after Authentication
Select the time to wait before sending email after POP authentication is done.

Authentication
Select either POP or APOP as the authentication method for POP before SMTP.
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CSV Settings Dialog Box

To open the CSV Settings dialog box, select CSV Settings from the Tools menu.

You can set the items to export to a file in CSV format.

Note
• The items you select in the CSV Settings dialog box are exported to the CSV file exported in the•

following ways.

Exporting Cost Tabulation Results to CSV File
Exporting Cost Information to a File

Item
Shows the items that you can export to a file in CSV format. Select the items you want to export.

125


